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MetaTrader

It is an electronic trading platform widely used by brokerage services and Forex traders, 

futures exchange and CFD markets. The software was developed by MetaQuotes and 

released in 2005. MetaTrader became popular because it allows users to write scripts and 

build robots, a feature that automation trading and Simplification the work of traders. As of 

June 2016, the fourth version of the platform will be widely used along with the fifth version, 

the first, second and third versions will no longer be used and supported, and the fourth 

version will expire over time.

The use of MetaTrader is permitted for brokers who provide this software to their customers. 

STP Trading Broker provides MetaTrader 5 to its customers to see the price of currencies 

and live charts, place orders and manage their accounts, In addition to Windows, its also 

available for Android and iOS. This software does not have an official version for the Mac 

operating system, however Mac users can use a compatibility layer such as Wine to run the 

program on this operating system (and other operating systems).
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MetaTrader5 Download Links

Desktop Terminal

https://download.mql5.com/cdn/web/17187/mt5/stptrading5setup.exe

Mobile iOS

https://download.mql5.com/cdn/mobile/mt5/ios?server=STPTrading-Demo,STPTrading-Live

Mobile Android

https://download.mql5.com/cdn/mobile/mt5/android?server=STPTrading-

Demo,STPTrading-Live
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https://download.mql5.com/cdn/web/17187/mt5/stptrading5setup.exe
https://download.mql5.com/cdn/mobile/mt5/ios?server=STPTrading-Demo,STPTrading-Live
https://download.mql5.com/cdn/mobile/mt5/android?server=STPTrading-Demo,STPTrading-Live
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How to Login to MetaTrader in Windows

1. First, click on the File
tab

2. Then click on     Open 
an Account option
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3.In this field, type STP

Trading Broker, then 

select Find your broker

4.Then the name STP

Trading broker will appear 

and select it

5. Then click Next

How to Login to MetaTrader in Windows
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6.Click on connect with an 

existing trade account

7.In the Login field, enter 

the 7-digit account 

number of your demo or 

real account

8. In the Password field, 

enter the password of 

your demo or real account

9.In the Server section, 

select Live if your account 

is Real and Demo if it is 

Demo

10.Finally, select the 

Finish option

How to Login to MetaTrader in Windows
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1.First, click on Tools tab

2. Then click on Options

MetaTrader 5 Password change in Windows
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MetaTrader 5 Password change in Windows

3.Then click on change

option
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4.Enter your previous 

password in the current 

password field

5.Enter the new password 

in the New password 

section

6.In the Confirm field,enter

the new password again

7. Then click Ok

MetaTrader 5 Password change in Windows



9

Toolbar

Menu bar

Data Window

Market Watch

Navigator

Toolbox PING

Account Information

Introducing MetaTrader environment in Windows

Create 

MQL link



1.In this section, you can 
see your account details 
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Introducing MetaTrader environment in Windows

2.The main menu of 
MetaTrader which includes 
different parts 

3.The Standard toolbar 
contains the general 
MetaTrader commands 

4.Line Studies toolbar 
contains commands for 
drawing lines and shapes 

5.Timeframes are used to 
manage the time intervals of 
charts 



1.Ping: This section displays 
your connection status to 
the broker server
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Introducing MetaTrader environment in Windows

2.Chart Bar: This section 
displays the list of charts that 
you have opened

3.This section is for 
connecting the account to the 
MQL site 

5.By clicking on Sell or Buy, 
you can instantly place a 
sell or buy order with the 
specified volume 
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How to work with Market Watch window

All prices of trading symbols are displayed live in the Market 
Watch section. 

To add Market Watch window, you can click the Market Watch
option in the View section or use the CTRL + M shortcut keys

By default, only the symbol name, selling and purchase prices are displayed, but 

you can add other fields to the table.

New Order: This option is to open the order (trade) window. 

To open a chart, you must right-click on the symbol and select Chart Window. 

Select Specification to display the specifications and the open/close times of the 

selected symbol.

Click on Hide All to hide all trading symbols. 

Click Show All to display all trading symbols. 

Columns: In this section you can add other fields to the table, such as

spread value of each symbol and etc.
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(Navigator) window allows the user to quickly access the various 

features of MetaTrader. To activate you can click on Navigator 

Window in the View section or use the CTRL + N shortcut. 

This window contains trading account information, technical 

indicators, experts, personalized indicators, and scripts

In the Accounts section, all active trading accounts are displayed. 

Open An Account is to log in to a trading account. 

Login to Trade Account is to log in to the trading account which already 

defined in MetaTrader. 

Change Password is to change the account password. 

Delete : Use this option to remove a trading account from the list of

Accounts.

How to work with Navigator window
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Terminal window (Toolbox) : In this section we can see all the 

activities performed in the chart like observe and control open 

transactions, transaction history, news, emails sent by the broker 

and etc…

How to work with Toolbox window
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Trade: In this section,you can see informations such as Balance, Equity, Margin, Free Margin, Margin Level and 

open transaction information, name of the currency pair, time of the transaction, type of transaction )purchase or 

sale(, price, volume, stop loss and take profit of the transaction and the amount of profit or loss of the transaction.

Balance: The amount of your deposit for a trade and its fixed as long as you have a trade open.

Equity: displays the amount of your account balance,including profit or loss, and varies as long as you have an 

open trade. After closing open trades, you can withdraw the amount from your account

Equity = Balance + (Profit or Loss)

Margin: is the amount of money used to open a trade, the amount of margin depends on the amount and the 

symbol of the traders choice. 

Free Margin: is the amount of margin of which you can open new trades or withdraw.

Margin Level: indicates the status of your account, if this number falls below 100%, MetaTrader wont allow you to 

open a new trade and you can only hedge. If this number reaches 30%, your account will be callmargin.
Margin Level = Equity / Margin * 100

How to work with Toolbox(Trade) window
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History: In this section, you can see the history of closed trades, profit and loss of 

closed trades, amount of commission and swap (overnight interest), etc. 

All History: displays all transactions made since the account was opened until the 

execution of this command

Last 3 Months: Displays the accounts report for the last 3 months

Last Month: Displays the accounts report for the last month

Custom Period: Trades report for a specific time period specified by the trader.

Report: the statement of the account, you must proceed from this section. 

Columns: In this section you can add fields to display in the History table.

How to work with Toolbox(History) window
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Chart: In this section, you can see the price of different symbols. 

At the bottom of the chart, there is a chart switch bar which contains the 

name of the trading symbol and time frame, and you can select desired 

symbols chart

One Click Trading: you can trade with just one click

Properties: You can make chart settings in this section

How to work with Chart section
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) One Click Trading ( Activation

Simultaneously in the (One Click Trading) panel you can see the supply 

and demand prices as well as the volume window and with one click you 

can instantly place a sell or buy order with the specified amount.

Note that no confirmation is required by the system to register the 

command
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Settings for the Properties chart

In the Common section, settings related to chart display 

are made

In Show section, settings for displaying lines on the chart 

are made which makes you to manage transactions more 

accurately. 

The Show Ask Line is for displaying the Ask price         

(the price that broker offers you). 

The Show Bid Line option is for displaying the Bid price 

(the price that broker asks you for)
.

In Colors section, you can change the settings for the 

charts color.



Trading in MetaTrader 

Order management is a very important aspect of your trading strategy that is also essential 

for better risk management. While the trade may be just as simple as pressing the BUY or 

SELL button or close your trade in profit or loss but there are many ways to use all kinds of 

buying and selling orders

Buying and selling orders are generally divided into two categories:

-Market Orders 

-Pending Order

Market orders

This type of order is familiar to people who have worked in Forex. These types of orders are 

buying and selling at the current market prices and are done as simple as pressing the BUY 

or SELL keys. 

Limited Orders

These types of orders are mostly used by experienced and professional traders. Limit Order 

is a buy and sell order at a certain price. Limited orders may or may not be

completed depending on market conditions. These orders are made only at the specified  

price or better.
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Pending Orders are divided into several categories: 

1.Buy Limit: The use of this order is when the user intends to buy a symbol at a price lower than 

the current market price. In this type of order, as soon as the Ask price reaches the price that set 

by the user, the purchase will be done by the queue.

2.Sell Limit: The use of this order is when the user intends to sell a symbol at a price higher than 

the current market price. Sell at a price set by the user that is equal to or higher than the Bid price. 

In this order, as soon as the bid price reaches the price that set by the user, the sale will be done 

by the queue.

3.Buy Stop: it is a strategic order and the use of it is when the user intends to buy at a price higher 

than the current market price. Buy at a price set by user that is higher than the current Ask price.

4.Sell Stop: it is a strategic order and the use of it is when the user intends to sell at a price lower 

than the current market price. Sell at a price set by user that is lower than current Bid price

5.Buy Stop Limit is a strategic order and its a combination of two types Buy Stop-Sell Limit orders. 

This order is used when the user intends to send the buy order to the trading system after 

reaching the market price at the set price. 

6.Sell Stop Limit is a strategic order and its a combination of two types Sell Stop-Sell Limit orders.      

The use of this order is when the user intends to send the sale order at a certain price to the 

trading system after reaching the market price.
21



Take Profit
Take Profit (TP) is a price that automatically closes with profitable trades, which for buy 

trades, Take Profit is higher than the current price and in sell trades is a lower than the 

current price.

Stop Loss
Stop Loss (SL) is the price at which, when we set it, the trades are closed automatically, 

which is lower than the current trading price for the buy trades and higher than the

Current price for sell trades.

22
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First, click on the New Order option

In the Symbol field, select the desired symbol.

In the Type field, select the Market Execution type. 

In the Volume field, select the trading volume. 

In the Stop Loss section , specify your loss limit. 

In the Take Profit section , specify your profit limit. 

Finally, click the Sell or Buy button

market conditions trading in MetaTrader (Part 1)
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In the Symbol field, select the desired symbol.

In the Type field, select the order type. 

In the Volume field, select the trading volume. 

In the Stop Loss section , specify your loss limit. 

In the Take Profit section, specify your profit limit. 

Finally, click the Sell or Buy button

In the Market Watch section, right-click on the desired 

icon

Then click on New Order

market conditions trading in MetaTrader (Part 2)
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Pending Order transaction in MetaTrader

In the Symbol field, select the desired symbol.

In the Type field, select the Pending Order type. 

In the Volume field, select the trading volume. 

In the Stop Loss section , specify your loss limit. 

In the Take Profit section, specify your profit limit. 

Finally, click the Sell or Buy button

This type of Order allows you to trade at the prices you 

are analyzing, it means that in the Pending Order 

settings you order to open the trade as soon as the chart 

reaches the X point

To perform Pending Order transactions you must select 

this option in the type field. 
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File menu in MetaTrader 5

After clicking on the File menu, the referred 

image will appear

New Chart is for opening new charts

Open Data Folder: By opening this folder 

you will have access to saved data, price 

history, MetaTrader configuration files and 

MQL5 application.

Open an Account is to log in to a trading 

account

Login to Trade Account is to log in to the 

trading account that already defined in 

MetaTrader
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After clicking on the View menu, the referred image will 

appear. 

From Languages section You can change the language 

of the program

Toolbars, Status Bar, Charts Bar, each of which is used 

to make settings. 

In the Toolbars section, you can activate the Standard 

bar, Line Studies bar and Timeframes bar 

The Symbols section is for watching the symbols and 

displays them in the Market Watch section. 

Market Watch Click on this part of the Market Watch 

window will appear. Data

.Window is for evaluating the opening and closing of the 

price and its floor and ceiling

.Navigator where trading and technical information is 

provided

.Toolbox is the action management section

.Full screen If you click this option, the MetaTrader 

software will cover your entire screen

View menu in MetaTrader 5
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After clicking on the Insert menu, the opposite 

image will appear

Indicators: This section is for viewing 

indicators and adding them to the chart

Objects: This window contains all technical 

analytics lines, symbols, shapes and texts. 

Experts: Through this section, various 

strategies can be given to software as plans.

Scripts: Scripts are more common among 

professional traders and are used in a variety 

of situations. The task of a simple script may 

just be to close multiple open positions 

simultaneously and a complex script may also 

be an integral part of your trading strategy

Insert menu in MetaTrader 5
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By clicking on Charts menu opposite image will appear

Bar Chart: you select this option, the price will be shown 

in the form of bar chart.

Candlesticks: by selecting this option prices will be shown 

in the form of candles. 

Line Chart: selecting this will causes market prices to be 

displayed in the form of a line chart. 

Timeframes: Selecting this option displays a menu of 

time frames for price candles to open and close. 

Templates: in this section you can add your own made or 

selected templates to the chart. You can also save new 

templates or delete old ones. Note that you cannot delete 

the default template. 

Grid: In this section you can display grid lines in the 

background of the chart. 

Auto Scroll is used to automatically move the chart to the 

left until the price candle closes

Charts menu in MetaTrader 5
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Chart Shift: This option is for moving the chart to move 

away from the right edge of the price window. 

Volumes: This option shows the volume of trades in the 

price chart

Trade Levels: Trading orders and pending orders can be 

seen with horizontal lines on the price chart. 

Trade History: Closed trades can be seen on the price 

chart. 

Zoom in: this section is for magnifying the price data on 

the chart. 

Zoom Out: This section is for displaying small price data 

on the chart. 

Step by Step: Selecting this option moves the candlestick 

price chart to the left. 

Properties: By clicking on this command you can change 

the settings and parameters of price charts. Clicking on 

this command will open the price chart settings window

Charts menu in MetaTrader 5
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After clicking on the Tools menu, the opposite image 

will appear

New Order: This option opens a transaction 

management window. In this section you can use 

this window to execute a new transaction

Meta Quotes Language Editor: This option is for 

editing the MQL programming language and you 

can use it to write new experts, scripts or indicators

Global Variables: This option connects you to the 

MetaTrader variables window used in Experts, 

Personalized Indicators, and Scripts

Options: In this section you can make settings 

related to internet connections, transactions, charts, 

experts and other settings

Tools menu in MetaTrader 5 
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After clicking on the Window menu, the opposite 

image will appear

Tile Windows is to display all price charts at the 

same time

Cascade is to display all price charts as cascade 

charts

Tile Horizontally is to display price charts 

horizontally side by side

Tile Vertically is to display price charts vertically side 

by side

Arrange Icons All price charts that have been 

Minimized will placed at the bottom of the 

MetaTrader. 

A list of charts that are active is displayed in this 

section and any active chart will be marked

Window menu in MetaTrader 5 
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After clicking on Help menu, the 

opposite image will appear

Help Topics is for activating the 

MetaTrader user manual

Online Search is for online 

searching

Video Guides is a video guide

About is about MetaTrader

Help menu in MetaTrader 5 
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Add indicators in MetaTrader 5

To add an indicator to MetaTrader, follow 

these steps :

1.Find the Forex indicator you want and 

download it to your computer.

2.Like the image, go to the Open Data 

Folder tab from the File menu.

3.in the opened window, go to MQL> 

Indicators and put the indicator file you 

want there.

4.Close your MetaTrader once and open it 

again.

5.You can see the added indicator from the 

Insert menu in the Indicators section.



MetaTrader 5 shortcuts

Arrow Left: This key causes the timeline to be moved to the left

Arrow Right: This key causes the timeline to be moved to the right

Arrow Up key : This key allows the timeline to be moved quickly to the left

Arrow Down key : This key allows the timeline to be quickly moved right

Num-pad 5: If your keyboard has a separate section for accounting 

operations, you can return the price chart to normal by pressing key number 

5.If the time chart scale is predefined, this key will move the price chart to 

the user's visible range

Page Up: Quickly move the price chart to the left

Page Down: Quickly move the chart to the right

Home: Moves the price chart to the starting point

35



End: Moves the chart to the last (latest) price candle

Zoom Out: Shrinks the price chart

Zoom In: zoom the price chart

Delete: Deletes all objects that have been added to the price chart and are in 

Selected mode

Backspace: Clears the last object added to the chart

Enter: Opens the Fast Navigation window

Esc: Closes all open MetaTrader dialog boxes

F1: Opens the MetaTrader guide

F2: Opens the History Center window

F3: Opens the Global Variables window 36



F4: Opens the Meta Editor software

F6: Opens the Tester window

F7: Opens the expert settings window attached to the price chart

F8: Opens the chart settings window

F9: Opens the New Order window

F10: Opens the Popup Prices window

F11: Enables or disables full screen display mode

F12: Moves the price chart to the left in the size of one candlestick

Shift + F12: Moves the price chart in the size of one candlestick to the right

Shift + F5: Displays the previous profile 37



Alt + 1: Changes the price chart to a bar chart

Alt + 2: Changes the price chart to a candlestick chart

Alt + 3: Changes the price chart to a line chart

Alt + A: Copies test results and optimizations to PC short-term memory

Alt + W: Opens the chart management window

Alt + F4: Closes the terminal window

Alt + Backspace or Ctrl + Z: Cancels deleting objects added to the chart and 

returns the objects to the chart

Ctrl + A: Restores the height of all windows by default

Ctrl + B: Opens the Object List window 38



Ctrl + C or Ctrl + Insert: Copy command

Ctrl + F: Switches the mouse pointer to Crosshair mode

Ctrl + G: Deletes or displays the Grid

Ctrl + H: Displays or hides the OHLC line

Ctrl + I: The window shows the list of indicators applied to the chart

Ctrl + L: Deletes trading volume data from the chart or adds it to the chart

Ctrl + P: Print from the chart

Ctrl + S: Saves charts with CSV, PRN or HTM extensions

Ctrl + W or Ctrl + F4: Closes the price chart

Ctrl + Y: Displays or hides time periods in the price chart
39



Ctrl + Z or Alt + Backspace: Returns items deleted from the price chart

Ctrl + D: Opens the Data window. If the window is open it will close

Ctrl + M: Opens the Market Watch window. If the window is open it will close

Ctrl + N: Opens the Navigator window. If the window is open it will close

Ctrl + O: Opens the Setup window. If the window is open it will close

Ctrl + R: Opens the Tester window. If the window is open it will close

Ctrl + T: Opens the terminal window. If the window is open it will close

Ctrl + F5: Changes the price chart profile to the next profile in the list

Ctrl + F6: Activates the next price chart window
40
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Basic Forex Concepts

Balance is your account balance before the trade is open, when you open the trade the 

balance number does not change, but after the trade is closed, it is added or subtracted to 

the balance! 

Equity is the account balance at that moment. This means that if you close all the 

transactions at this moment, you can withdraw as much money as the equity number

Margin is the money used to open a trade. This amount is directly related to the volume of 

the trade, and the higher the volume, the more margin is used

Free Margin is the amount of account balance left after opening positions, so as this number 

you can open a new trade

Margin Level indicates your account. Pay close attention to this number in your transactions

Pullback When a support surface breaks with resistance, it sometimes returns to the broken 

surface and continues on its way again, this is called pullback
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Basic Forex Concepts

Margin Call is for when the account margin is in danger and warns you that your account is 

closing and turns red

Stop out is for when the account does not have a margin level and starts closing the 

position, and usually the position with the most negative is closed and eventualy close all 

the positions in order

Swap overnight interest rates are amounts that are calculated on the profit of open trades, 

that is, when you open trades and it reaches 12 o'clock am , your trades swap

at that moment, and this can be positive or negative

Spread The difference between Ask and bid is called Spread

Ask is the price level where we buy a currency pair

Bid is the price level where we sell a currency pair

Loss Limit (SL) The maximum amount of damage allowed in a trade, which is usually 

abbreviated to SL

Profit Limit (TP) is the price or price range that automatically closes a position to win a profit 

and abbreviated to SL
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Basic Forex Concepts

LOT is the smallest size available in a currency used to trade in Forex market

PIP stands for Point in Percentage and is used among all traders in international markets and 

is a measure of the change in currency pairs

Trigger The word trigger is used for a situation where the trader has taken all the steps and is 

just waiting for the right opportunity to enter the stock

Swap interest rate When you receive a loan from the bank, in addition to repaying the 

principal of the loan, you pay an excess amount to the bank, in fact the amount you pay to 

compensate for the devaluation of the money paid today and receive in the future. 

Technical analysis is an analysis in Forex that is done to predict prices in financial markets 

through studies of the past market situation, which is based on market price
fluctuations
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Basic Forex Concepts

Fundamental analysis is the study of factors that fundamentally affect the price of what you 

trade

The Federal Open Market Committee (FOMC) consists of twelve members, seven members 

of the Federal Reserve Council, the chairman of the Federal Reserve Bank of New York, 

and four of the remaining eleven chairmen of the Reserve Bank of America 

Non-agricultural employment in the United States is called the NFP, which is a monthly 

economic report. The report is published every month and shows the work situation in this 

country

GDP is the most important macroeconomic analysis of any country, in a way it shows the 

welfare and standard of living of any country

PMI Index is studied by the Purchasing Managers Association with a review of 300 

purchasing managers from 20 different industries, if this index is above 50%, business 

conditions improve and if less than 50% Indicates the contraction of the economy
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Basic Forex Concepts

PPI stands for Producer Price Index, which is an important part of economic information, 

and information about this index is published in the second week of each month

The CPI index shows changes in the price level of the market basket of consumer goods 

and services purchased by households. This index is a statistical estimate that uses the 

price of a sample of items whose prices are collected periodically.

Leverage In a simple sense allows the trader to enter into larger trades with less deposit 

money. For example, if a trader uses a 1: 100 leverage, that means 1 dollar of his deposit 

allows him to make a $ 100 trade.



STP Trading broker is one of the few NDD brokers that 

provides safe and secure services to traders around the 

world and all accounts are connected to the reference

bank in the United Kingdom, and all accounts are 

covered by insurance from the time the account is 

charged

Experience all kinds of accounts with floating compact 

spreads on this broker's very fast platform

STP Trading broker
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https://facebook.com/stptrading.broker
https://t.me/stpforex_en
https://instagram.com/stpforex_en
https://twitter.com/stp_forex
https://wa.me/+905526282249
https://www.youtube.com/channel/UCmBESXBCRDGaoiZfKzttHkA
https://www.stp.forex/
https://www.instagram.com/stp_broker

